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[bookmark: Long_Abstract]SUMMARY: 
We present a detailed protocol to generate a murine xenograft model of venous malformation. This model is based on the subcutaneous injection of patient-derived endothelial cells containing hyper-activating TIE2 and/or PIK3CA gene mutations. Xenograft lesions closely recapitulate the histopathological features of VM patient tissue. 

ABSTRACT: 
Venous malformation (VM) is a vascular anomaly that arises from impaired development of the venous network resulting in dilated and often dysfunctional veins. The purpose of this article is to carefully describe the establishment of a murine xenograft model that mimics human VM and is able to reflect patient heterogeneity. Hyper-activating non-inherited (somatic) TEK (TIE2) and PIK3CA mutations in endothelial cells (EC) have been identified as the main drivers of pathological vessel enlargement in VM. The following protocol describes the isolation, purification and expansion of patient-derived EC expressing mutant TIE2 and/or PIK3CA. These EC are injected subcutaneously into the back of immunodeficient athymic mice to generate ectatic vascular channels. Lesions generated with TIE2 or PIK3CA-mutant EC are visibly vascularized within 7‒9 days of injection and recapitulate histopathological features of VM patient tissue. This VM xenograft model provides a reliable platform to investigate the cellular and molecular mechanisms driving VM formation and expansion. In addition, this model will be instrumental for translational studies testing the efficacy of novel drug candidates in preventing the abnormal vessel enlargement seen in human VM. 

[bookmark: Introduction][bookmark: Protocol]INTRODUCTION:
Defects in the development of the vasculature are the underlying cause of many diseases including venous malformation (VM). VM is a congenital disease characterized by abnormal morphogenesis and expansion of veins1. Important studies on VM tissue and endothelial cells (EC) have identified gain-of-function mutations in two genes: TEK, which encodes the tyrosine kinase receptor TIE2, and PIK3CA, which encodes the p110α (catalytic subunit) isoform of PI3-kinase (PI3K)2–5. These somatic mutations result in ligand-independent hyper-activation of key angiogenic/growth signaling pathways, including PI3K/AKT, thereby resulting in dilated ectatic veins3. Despite these important genetic discoveries, the subsequent cellular and molecular mechanisms triggering abnormal angiogenesis and the formation of enlarged vascular channels are still not fully understood. 

During normal and pathological angiogenesis, new vessels sprout from a pre-existing vascular network and EC undergo a sequence of important cellular processes including proliferation, migration, extracellular matrix (ECM) remodeling and lumen formation6. Two- and three- dimensional (2D/3D) in vitro cultures of EC are important tools to investigate each of these cellular properties individually. Nevertheless, there is a clear demand for a mouse model recapitulating pathological vessel enlargement within the host microenvironment while providing an efficient platform for preclinical evaluation of targeted drugs for translational research. 

Up to date, a transgenic murine model of VM associated with TIE2 gain-of-function mutations has not been reported. Current transgenic VM mouse models rely on the ubiquitous or tissue-restricted expression of the activating mutation PIK3CA p.H1047R3, 5. These transgenic animals provide significant insight into whole-body or tissue-specific effects of this hotspot PIK3CA mutation. The limitation of these models is the formation of a highly pathological vascular network resulting in early lethality. Thus, these mouse models do not fully reflect the sporadic occurrence of mutational events and localized nature of VM pathology. 

On the contrary, patient-derived xenograft models are based on the transplantation or injection of pathological tissue or cells derived from patients into immunodeficient mice7. Xenograft models are a powerful tool to broaden knowledge about disease development and discovery of novel therapeutic agents8. In addition, using patient-derived cells allows scientists to recapitulate mutation heterogeneity to study the spectrum of patient phenotypes. 

Here, we describe a protocol where patient-derived VM EC which express a mutant constitutively-active form of TIE2 and/or PIK3CA are injected subcutaneously in the back of athymic nude mice. Injected vascular cells are suspended in an ECM framework in order to promote angiogenesis as described in previous vascular xenograft models9–11. These VM EC undergo significant morphogenesis and generate enlarged, perfused pathological vessels in the absence of supporting cells. The described xenograft model of VM provides an efficient platform for preclinical evaluation of targeted drugs for their ability to inhibit uncontrolled lumen expansion. 

[bookmark: _Hlk40354656]PROTOCOL: 
[bookmark: Representative_Results]Patient tissue samples were obtained from participants after informed consent from the Collection and Repository of Tissue Samples and Data from Patients with Tumors and Vascular Anomalies under an approved Institutional Review Board (IRB) per institutional policies at Cincinnati Children’s Hospital Medical Center (CCHMC), Cancer and Blood Disease Institute and with approval of the Committee on Clinical Investigation. All animal procedures described below have been reviewed and approved by the CCHMC Institutional Animal Care and Use Committee.

Preparation of materials and stock solutions

Preparation of complete endothelial cell growth medium (EGM) 

Supplement endothelial basal medium (EBM) with the following growth factors present in the kit (see Table of Materials): human Fibroblast Growth Factor-Beta (hFGF-β), vascular endothelial growth factor (VEGF), Long Arg3 Insulin-Like Growth Factor- I (R3-IGF-I), ascorbic acid, epidermal growth factor (EGF), gentamycin sulphate and amphotericin-B, and heparin. Add 1% Penicillin/Streptomycin/L-Glutamine (PSG) solution and 20% fetal bovine serum (FBS).

NOTE: We do not recommend adding hydrocortisone.

Sterile filter the solution under a laminar flow hood through a 0.2 µm bottle top filter into an autoclaved glass bottle and aliquot media into 50 mL conical tubes and store at 4 °C up to a week or at -20 °C for up to one year. 

Prepare collagenase A stock solution

Prepare 50 mg/mL collagenase A stock solution in 1x phosphate buffer saline (PBS).

Sterile filter the solution under a laminar flow hood with 0.2 µm filter and syringe, and store 100 µL aliquots at -20 °C. 

Prepare tissue collection medium (Buffer A) 

Prepare a Ca2+/Mg2+ stock solution by adding 0.927 g of calcium chloride dihydrate (CaCl2.2H2O) and 1 g of magnesium sulfate heptahydrate (MgSO4.7H2O) to 500 mL of distilled water. Sterile filter the solution through a 0.2 µm bottle top filter into an autoclaved glass bottle and store at room temperature (RT). 

Supplement Dulbecco's Modified Eagle Medium (DMEM) with 10% Ca2+/Mg2+ solution and 2% FBS. 

Sterile filter the solution under a laminar flow hood with 0.2 µm filter and syringe and store aliquots of 5 mL at -20 °C. 

Fibronectin coating of tissue culture plates

Prepare coating buffer (Buffer B) by dissolving 5.3 g of sodium carbonate (Na2CO3; 0.1 M) in 500 mL of deionized water. Adjust the pH of the buffer to 9.4 using 1 M hydrochloric acid (HCl). Filter under a laminar flow hood through a 0.2 µm bottle top filter into an autoclaved glass bottle and store at RT. 

For coating, pipette 2 mL/5 mL/10 mL of Buffer B per 60 mm/100 mm/145 mm tissue culture plate, respectively. Add 1 µg/cm2 of human plasma fibronectin purified protein solution and gently distribute the liquid onto the plate.

Incubate plate at 37 °C, 5% CO2 for 20 min. 

Aspirate Buffer B and wash the plate with PBS prior to culturing cells.

Isolation of endothelial cells from VM patient tissue

Isolation of EC from solid VM tissue 

NOTE: VM tissue is resected by debulking surgery12, 13 under an IRB approved protocol.

Wash VM tissue (tissue sample weight typically ranges between 0.5 g and 1.5 g) in 5% PSG in PBS. 

Transfer tissue to a 100 mm cell culture dish, mince tissue sample into small pieces using sterile surgical dissection tools, and transfer into a 50 mL conical tube. 

Add 100 µL of collagenase A stock solution to 5 mL of Buffer A for a final concentration of 1 mg/mL, then add this to the tissue and digest the minced tissue at 37 °C for 30 min while shaking contents every 5 min. 

Carefully grind the digested tissue at RT using a 6 mm, smooth-surface pestle grinder within the 50 mL conical tube.

Continue to carefully grind digested tissue using a pestle while adding 5 mL of cold PBS supplemented with 0.5% bovine serum albumin (BSA) and 2% PSG. Repeat this step four times.

Filter the solution through a 100 μm cell strainer into a 50 mL conical tube to remove tissue fragments. 

Centrifuge cell suspension for 5 min at 400 x g at RT. Proceed to step 2.3.

Isolation of VM EC from lesional blood obtained from patient sclerotherapy

Obtain human VM lesional blood from sclerotherapy under an IRB approved protocol.

Dilute lesional blood (sample volume typically ranges between 0.5 mL and 5 mL) in PBS to a final volume of 40 mL.

Centrifuge cell suspension for 5 min at 200 x g at RT. 

Initial cell plating 

Discard supernatant and resuspend the single-cell pellet in 1 mL of EGM. 

Add 9 mL of complete EGM onto fibronectin-coated (1 µg/cm²) 100 mm plates and seed 1 mL of cell suspension. 

Incubate cells at 37 °C in a humidified 5% CO2 atmosphere.

Every other day remove 2 mL of media and add 2 mL of sterile filtered FBS. 

Once cell cultures reach a confluency of 40‒50% change the medium to complete EGM. It typically takes between 2‒3 weeks for the cells to reach this confluency. 

Observe daily for the appearance of EC colonies. They can be recognized by their typical “cobblestone-like” morphology (Figure 1A). Between 3‒5 EC-colonies appear in each sample. 

Change the medium every other day for another 5‒7 days until individual EC colonies start to touch one another. 

Manual isolation of individual EC colonies 

To harvest EC colonies, wash the plate with 5 mL of PBS and manually aspirate with a serological pipette. 

Take the plate to a microscope and circle the locations of multiple EC colonies using a marking pen both on lid and bottom before returning it to laminar flow hood. 

Detach EC colonies by pipetting 50 µL of 0.05% trypsin-EDTA solution on the marked areas. 

Using a small cell scraper or a pipette tip, gently scrape cells from plate.

Tilt the plate to the nearest edge, and rinse with 1 mL of EGM to neutralize per marked area and collect cells.

Count the number of cells using a hemocytometer or automated cell counter.

Plate the collected EC colonies at a density of 1 x 104 cells/cm2 onto fibronectin-coated (1 µg/cm²) cell culture dishes containing fresh EGM. The next day, change medium to complete EGM. 

Change the medium to complete EGM every other day for 2‒3 weeks until cells reach 80% confluency. 

Trypsinize EC with 2 mL of pre-warmed 0.05% trypsin-EDTA per 100 mm dish at 37 °C for 2 min and neutralize trypsin by adding 4 mL of EGM. 

Collect the cell suspension into one 15 mL conical tube and centrifuge at 400 x g at RT for 5 min. Aspirate the supernatant and resuspend cells in 2 mL of EGM. 

Count the number of cells using a hemocytometer or automated cell counter. Typical cell numbers obtained are 1 x 106 cells per 60 mm cell culture plate or 2 x 106 cells per 100 mm tissue culture plate. 

Pellet the cells by centrifugation at 400 x g at RT for 5 min and aspirate the supernatant. Proceed to step 3.2.1.

Endothelial cell selection and expansion

Preparation of anti-CD31-conjugated magnetic beads

Vortex the vial containing the anti-CD31-conjugated magnetic beads for 30 s. The volume of beads required is 20 µL/2x106 cells.

Wash 20 µL of anti-CD31-conjugated magnetic beads with 1 mL of wash solution containing 0.1% BSA in PBS in a 1.5 mL microcentrifuge tube. 

Place the microcentrifuge tube in a cell isolation magnet for 1 min. 

Aspirate the supernatant and repeat the washing step. 

Endothelial cell purification and plating

Resuspend cell pellet obtained in 2.4.11 in 500 µL of wash solution containing 0.1% BSA in PBS.

Add cell solution to microcentrifuge tube containing magnetic beads and resuspend thoroughly.

Incubate for 20 min at 4 °C with gentle tilting. 

Add 500 µL of 0.1% BSA in PBS and mix well.

Place the tube on a cell isolation magnet for 1 min. 

Gently aspirate all of the liquid, which contains the CD31-negative fraction of cells without touching the beads.

Wash the bead pellet containing the CD31-positive cell fraction with 1 mL of 0.1% BSA in PBS and repeat magnetic separation.
 
Repeat washing and magnetic separation step for a minimum of 3 times to purify CD31-positive cell fraction. 

Resuspend purified endothelial cells into a 15 mL conical tube and spin down for 5 min at 400 x g at RT.

Remove supernatant and resuspend cell pellet in 1 mL of EGM. 

Add 9 mL of complete EGM onto fibronectin-coated (1 µg/cm²) 100 mm plates and seed 1 mL of cell suspension. Note that some magnetic beads are still attached to the cells in this initial seeding step. Most beads wash away during cell expansion, but small number of beads may persist in early passages. 

Incubate cells at 37 °C in a humidified 5% CO2 atmosphere.

Change the medium every other day until cells reach 80 % confluency.

Endothelial cell expansion

Once cells reach 80 % confluency, detach with 2 mL of 0.05% trypsin-EDTA per 100 mm dish at 37 °C for 2 min. 

Neutralize trypsin by adding 4 mL of EGM and collect cells into one 15 mL conical tube.

Centrifuge at 400 x g at RT for 5 min. 

Aspirate the supernatant, resuspend cells in 2 mL of EGM, and count the number of cells with a hemocytometer or by automated cell counting. 

Seed cells at a density of 1 x 104 cells/cm² into 145 mm fibronectin-coated (1 µg/cm²) tissue culture plates. 

Continue to passage cells until the desired cell number has been met. Consider that a confluent 145 mm tissue culture plate contains about 8‒9 x 106 cells and the number of cells needed is 2.5 x 106 cells per injection. Only cells between passage 3 and 8 should be considered for the xenograft. 

VM patient-derived xenograft protocol 

NOTE: In this protocol we use 5‒6 week old, male immunodeficient, athymic nude Foxn1nu mice. 
All animal procedures must be approved by the Institutional Animal Care and Use Committee (IACUC).

Preparation of materials on the day before injection 

Pre-chill syringes, needles, and pipet tips in -20 °C freezer overnight.

Slowly thaw the basement membrane extracellular matrix (BMEM) overnight on ice bucket placed at 4 °C to avoid increased viscosity of the gel.

Preparation of cell suspension for injection

Trypsinize EC with 5 mL of pre-warmed 0.05% trypsin-EDTA per 145 mm dish at 37 °C for 2 min. 

Neutralize trypsin by adding 5 mL of EGM and collect cells into one 15 mL conical tube.

Centrifuge at 400 x g at RT for 5 min. 

Aspirate the supernatant, resuspend cells in 3 mL of EGM, and count the number of cells using a hemocytometer or automated cell counter. 

Determine the total number of cells that are needed for all planned injections. 

NOTE: The recommended number of cells is 2.5 x 106 cells per injection. A total of 2 injections are typically performed in each mouse for technical duplicates. It is necessary to calculate a 10% excess of cell number to account for loss during transfer into the syringe. 

Transfer the volume containing the calculated cell number into a new 50 mL conical tube and pellet cells by centrifugation at 400 x g at RT for 5 min. 

Aspirate the supernatant, leaving a small volume (about 50‒70 µL) to loosen the pellet.

Syringe preparation 

Calculate an excess volume of 20 µL/injection to account for loss during transfer to the syringe. Resuspend the cell pellet with 220 µL of BMEM per injection on ice. The injected volume of cell suspension will be 200 μL per lesion.

Mix the cell suspension thoroughly on ice to obtain a homogenous cell suspension and avoid creating bubbles. 

Using a 1 mL pipet and 1 mL syringe, simultaneously pipet BMEM-cell mixture into the syringe opening by suction force while pulling plunger of syringe. 

Luer lock a 26G x 5/8 inch sterile needle to the syringe and keep prepared syringes flat on ice prior to injection.

Subcutaneous injection into mouse

Anesthetize the mice with 5% isoflurane/oxygen mixture at a flow rate of 1 L/min using an isoflurane vaporizer. Ensure proper sedation of animals (e.g., unresponsiveness to toe pinches). Maintain anaesthesia via continuous administration of 1.5% isoflurane/oxygen delivered via nose cone.

Place mice on their stomach, exposing the back region where grafting will occur and disinfect the injection region with 70% ethanol. 

Gently roll the prepared syringe to resuspend any settled cells. Flick bubbles to the needle end of the syringe and expel a small volume of the cell suspension to ensure the removal of all bubbles. 

NOTE: Two injections can be performed for each mouse – on the left and the right side of mouse back. 
 
Pinch and create a ‘tent-like’ structure using your thumb and index finger and insert the needle subcutaneously right under the skin. Ensure that the needle is only skin deep by releasing pinched skin to prevent injection into muscle tissue. 

Holding needle at 45° angle carefully inject 200 µL of the cell-suspension to create a small spherical mass (Figure 1C). 

Record mouse weight with a scale, ear tag the mouse, and return to cage. 

Monitor mice following sedation to ensure they return to normal activity.

Lesion growth monitoring

Using a caliper, measure the length and width of each plug (Figure 1D). 

Document measurements every other day up until lesion collection. 

Tissue collection and processing	

Euthanize mice 9 days post-implantation in a CO2 chamber and check vital signs to confirm death. Perform cervical dislocation on the mice as a secondary method to euthanize the mouse. 

Harvest the xenograft lesion/plug from the flank of the mouse by dissection using surgical forceps and scissors. 

NOTE: In order to prevent rupturing the blood-filled vessels within the plug, it is important to avoid touching the lesion plug with dissection tools and leave excessive surrounding tissue such as skin attached to the plug. 

Immerse the resected lesion in PBS to wash.

Set up a camera stage with a camera. Align plugs onto a cutting board with a ruler. Take an image of all plugs to record gross vascularity of lesions (Figure 1E).

Fix plugs by submerging in 10% formalin overnight at RT. 

Wash plugs in PBS the following day and move them into 70% ethanol. 

Process lesion plugs for paraffin embedding (pathology core). 

Lesion sectioning 

Use a microtome to cut 5 μm sections from the collected murine lesions onto positively charged slides. 

NOTE: For the subsequent analysis, sections in the center of the plug (about 50‒70 µm into the tissue) are of importance.

Melt paraffin at 60 °C for 1 h prior to staining.
 
De-paraffinize and re-hydrate tissue sequentially under a chemical fume flow hood. Therefore, incubate slide in xylene for 10 min, 100% ethanol (EtOH) for 5 min, 90% EtOH for 3 min, and 80% EtOH for 3 min. 

Rinse slide in deionized water for 5 min. 

Hematoxylin and Eosin (H&E)

Incubate sections in Hematoxylin for 2 min. 

Place slides in a staining jar and rinse in a sink by a steady stream of tap water until water is clear.

De-hydrate slides by incubating tissue sequentially in 70% EtOH for 1 min, 80% EtOH for 1 min, 90% EtOH for 1 min, 100% EtOH for 1 min, and fresh 100% EtOH for 1 min

Stain sections in Eosin Y for 30 s. 

Rinse in fresh 100% EtOH until solution is clear.

Incubate slide in xylenes for 2 min. Let slides dry for 5‒10 min under the fume hood.

Dispense a drop of permanent, non-aqueous mounting medium over xenografts sections and place coverslip on top. 

Allow slides to dry overnight before imaging. 

Immunohistochemistry 

Prepare antigen retrieval buffer (Tris-EDTA) by weighing 0.6 g of Tris-base and 1 mL of 0.5 M EDTA to 500 mL of deionized water. Adjust pH to 9.0 using 1 M HCl. Add 250 µL of Tween-20. 

Incubate de-paraffinized tissue slides (as obtained in step 6.2‒6.3) in a beaker with antigen retrieval buffer, stirring on a heating block, for 20 min at 95 °C. 

Remove the beaker from heating block, allow solution to cool to 35 °C then wash in PBS for 3 min.

Block tissue sections in 5% normal horse serum in PBS for 30 min at RT. 

Prepare a biotinylated Ulex europaeus agglutinin-I (UEA-I) working solution by diluting 20 µg/mL of biotinylated UEA-I in 5% normal horse serum in PBS. 

Pipet 50‒100 µL of UEA-I working solution per section and incubate for 1 h at RT in a humidifying chamber. 

Wash slides two times in PBS for 3 min.

Quench slide sections in 3% hydrogen peroxide for 5 min at RT.

Wash slides two times in PBS for 3 min.

Prepare 5 µg/mL of Streptavidin horseradish peroxidase-conjugated in 5% normal horse serum in PBS. 

Pipet 50‒100 µL on each tissue slide and incubate for 1 h at RT in a humidifying chamber.

Wash slides two times in PBS for 3 min.

Prepare 3,3'Diaminobenzidine (DAB) solution according to manufacturer’s instructions and add 50‒100 µL per section. 

Incubate sections for 10‒15 min, checking and monitoring for development of stain every 2‒5 min. 

Wash slides three times in PBS for 3 min.

Add a drop of Hematoxylin and incubate for 3 min. 

Place slides in a staining jar and rinse in a sink by a steady stream of tap water until water is clear.

Sequentially incubate slide in 80% EtOH for 1 min, 90% EtOH for 1 min, 100% EtOH for 1 min, and xylene for 2 min. 

Let slides dry for 5‒10 min under the fume hood.

Dispense a drop of permanent, non-aqueous mounting medium over xenografts sections and place coverslip on top. 

Allow slides to dry overnight before imaging.

Analysis of human-derived Vascular Channels 

NOTE: Vascularity of VM lesions is quantified by measuring vascular area and vascular density. Only UEA-I positive, human-derived vascular channels are considered for quantification. 

Take four to five images per lesion section with a bright field microscope at a 20x magnification (high power fields [HPF]). Take HPF images in an x-plane pattern within the lesion section to avoid overlap (Figure 1F). Include a scale bar on the images taken.

Open and the HPF images in Image J (File > Open). Calibrate the pixels of the scale bar as follows. Use the straight line tool and go over the scale bar. To convert the measured pixels into mm click on Analyze > Set scale. 

Click on Analyze > Set Measurements and select Area. 

Measure the total field area in a HPF using Analyze > Measure. Save this measurement for quantification in step 9.8. 

Using the freehand selections tool, manually outline UEA-I+ vascular channels. 

NOTE: A vascular channel is defined as any area that is lined with UEA-I+ - EC that may contain blood cells. 

Click on Analyze > Measure to quantify the outlined UEA-I+ vascular area (mm2/HPF).

Repeat this measurement for all five HPF taken within one plug. 

Average the total vascular area of all five HPF (divide by 5). The obtained vascular area per HPF is subsequently divided by the HPF field area (in mm2, step 9.5) and expressed as a percent (%).

For quantification of vascular density, count the number of UEA-I+ vascular channels of each HPF taken. The vascular density is the average number of UEA-I+ vascular channels counted per HPF area (vessels/mm2).

REPRESENTATIVE RESULTS:
This protocol describes the process of generating a murine xenograft model of VM based on the subcutaneous injection of patient-derived EC into the back of immunodeficient nude mice. A scheme summarizing the steps from VM-EC isolation to dissection of lesion plug is presented in Figure 2. Endothelial cell colonies can be harvested within 4 weeks after initial cell isolation from VM tissue or lesional blood. The day after injection, the xenograft lesion plug covers a surface area of approximately 80‒100 mm2. In our hands, lesion plugs with TIE2/PIK3CA-mutant EC are visibly vascularized and perfused within 7‒9 days from injection 14, 15 (Figure 1C,D). However, the extent of lesion growth is variable and reflects on patient and sample heterogeneity. 

Lesion plugs closely recapitulate the histopathological features of human VM tissue: enlarged vascular channels lined by a thin layer of endothelial cells (Figure 1F‒H). These vascular structures typically contain erythrocytes, confirming functional anastomoses with the host mouse vasculature (Figure 1F‒H). Immunohistochemical staining using the human specific lectin UEA-I can confirm that cells lining vascular lesions are derived from human implanted cells rather than mouse vasculature (Figure 1H). 

[bookmark: Figure_Legends]FIGURE AND TABLE LEGENDS: 

[bookmark: Discussion]Figure 1: Representative results. (A) Representative image of primary mixed cell culture three weeks after isolation from VM tissue before EC selection. Typical endothelial cell colony (EC) and contaminating fibroblast (FB). (B) Image of a purified (CD31 bead-selection) endothelial cell culture from VM patient-derived tissue. Scale bar = 200 µm. (C) The lesion will form a spherical structure. Vascularization is visible due blueish color through the skin of nude mice. (D) Dashed lines show how lesion size is recoded by measuring the length (L) and the width (W) using a caliper. (E) Photo of visibly vascularized, xenograft lesion explant at day 9. Scale bar = 1 cm. (F) Representative image of a lesion plug section. The x-plane pattern in which five high power field images are taken for quantification are indicated by white dashed boxes. Scale bar = 1000 µm. (G‒H) Representative images of VM lesion plug sections. (G) Hematoxylin and Eosin staining and (H) immunohistochemistry of human specific lectin UEA-I. Scale bar = 100 µm.

Figure 2: Schematic of the workflow to generate a patient-derived xenograft of VM. (A) Endothelial cells isolated from patient VM lesion solid tissue or lesional blood are plated and, when 80% confluency is reached, are selected by anti CD31-conjugated immunomagnetic beads and expanded. (B) For subcutaneous injection of EC, on day 0, skin on the backside of the mouse is pinched using forefinger and thumb to create a tent-like structure. Lesions are measured at day 1 and then every other day (red arrows) using a caliper through experimental day 9. Lesions are dissected and processed for histological analysis. 

[bookmark: Acknowledgments]DISCUSSION: 
Here, we describe a method to generate a patient-derived xenograft model of VM. This murine model presents an excellent system that allows researchers to gain a deeper understanding of pathological lumen enlargement and will be instrumental in developing more effective and targeted therapies for the treatment of VM. This can be easily adapted to investigate other types of vascular anomalies such as capillary lymphatic venous malformation16. There are several steps that are crucial for the successful generation of reproducible vascular lesions. First, the patient-derived endothelial cells must be pure (without the presence of other cell types) and growing exponentially at the time of injection. Contaminating fibroblast or other mesenchymal non-EC can be easily recognized by elongated morphology as shown in Figure 1A. On rare occasion, it is possible that even after purification using anti-CD31 antibody conjugated magnetic beads, a small number of non-EC remain in the culture. These cultures require further purification with endothelial specific cell surface markers. As an alternative approach, single cell clonal expansion of endothelial cells is possible. This would reinsure the homogeneity of mutant-EC as all of the cells within one culture would derive from one single cell. However, this approach is not recommended for VM-derived EC as cells tend to top their proliferation capabilities and convert into a senescent phenotype after 9‒10 passages. It is critical to use cells between passages 3‒8 for xenograft experiments and to not passage cells the day before the injection. 

The xenograft model can be modified to investigate other vascular anomalies carrying different activating mutations. Moreover, as patient tissue samples are difficult to access for some laboratories, the xenograft model can be adapted by using EC, such as human umbilical cord blood cells (HUVEC), genetically engineered to express the mutation/s known to cause dysfunctional vascular growth15, 17.

The number of cells recommended for the injection in the xenograft is 2.5 x 106 cells/200 µL of BMEM. However, if the cell number is insufficient it is possible to either reduce the number of injections per animal to one or to reduce the injection volume to a minimum of 100 µL. For the latter, it is however important to maintain the cell density ratio e.g., 1.25 x 106 cells/100 µL BMEM. When working with BMEM, all the steps must be performed on ice to avoid solidification of the cell suspension before injection. During injection, it is important and that the needle is inserted at an angle of 45° directly under the skin and away from the muscle tissue, as injecting into muscle impedes lesion reproducibility and makes the lesion dissection difficult. A total of two injections can be performed on each mouse—one on the right and one on the left side of each animal. The second injection in the same mouse can serve as a technical replicate. More injections on the back are not recommended as lesions grow over time and might interfere with each other. For statistical analysis in pre-clinical studies comparing xenograft plugs of treated versus untreated (vehicle only) mice, we recommend the use of a minimum of 5 animals (10 xenograft plugs) per study group. If available, the second injection could alternatively be used as a ‘internal control’ using non-mutant EC. We have used primary non-mutant EC, such as HUVEC, as a control and have shown that these cells formed a negligible number of small channels14, 15. Furthermore, in these HUVEC control lesion plugs, we have noticed infiltration of murine-derived vascular channels into the plug after day 9. If the experimental design requires longer incubation times, these infiltrating channels can be easily excluded from analysis by staining for a human-specific marker such as human-specific CD31 antibody or Ulex europaeus agglutinin I (UEA-I) that does not cross react with mouse.

To ensure that the lesion does not become a burden to animal health and wellbeing it is important to observe lesion size, record mouse weight daily, and pay attention to any side complications such as bleeding and bruising. If the lesion volume exceeds 500 mm3, the experiment has to be terminated. 

When vascular lesions are enlarged and perfused, extreme attention must be paid during dissection to avoid rupturing the lesion. It is important to avoid touching the lesion plug with dissection tools and leave excessive surrounding tissue (such as skin) attached to the plug. This prevents collapse of the vascular structures within the xenograft plug which would interfere with accurate analysis. 

Finally, to maintain consistency, it is important that the initial histological analysis begins in the center of the plug (about 50‒70 µm into the tissue) rather than the border regions where anastomosing mouse vasculature might be present. It is highly recommended to stain the tissue sections with a human-specific EC marker, such as UEA-I (Figure 1H) or an alternative human-specific antibody which will not cross-react with mouse, in order to confirm that vascular structures are formed by human-derived EC rather than invading mouse EC. 
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